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This instruction guide was created as a supplement to hands-on training not as stand alone 
documentation.  For more information and questions, feel free to contact Jerry Raynor, Maryland 
NRCS State Resource Conservationist @ 443-482-2908 with any questions that arise. 
E-mail address: jerry.raynor@md.usda.gov 
 

NOTE:  There is more help and instructions available within the RUSLE2 
Program than what is presented in these instructions by visiting the 
RUSLE2 web site at 
http://fargo.nserl.purdue.edu/rusle2_dataweb/RUSLE2_Index.htm 
Additional information is also available in the RUSLE2 program itself on the 
HELP screens. 

mailto:jerry.raynor@md.usda.gov
http://fargo.nserl.purdue.edu/rusle2_dataweb/RUSLE2_Index.htm
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WELCOME TO RUSLE2 
 
Version 2 of the Revised Universal Soil Loss Equation (RUSLE2) estimates soil loss from rill and 
interrill (sheet and rill) erosion caused by rainfall and its associated overland flow.  RUSLE2 uses six 
factors for climatic erosivity, soil erodibility, slope length, slope steepness, cover-management, and 
support practices to compute soil loss. 
    
RUSLE2 is a powerful tool for conservation planning, inventorying erosion rates over large areas, and 
estimating sediment production that might become sediment yield in watersheds.  It can be used on 
cropland, pastureland, rangeland, disturbed forestland, construction sites, mined land, reclaimed land, 
landfills, military lands, and other areas where surface overland flow occurs because rainfall is greater 
than infiltration. 
 
 

ABOUT THIS USER’S GUIDE 
 
The purpose of this User’s Guide is primarily to describe individual RUSLE2 factors and to provide 
guidance on how to choose values used by RUSLE2.  However, that information is best described by 
having the RUSLE2 program open and moving through the program as various topics are discussed.  The 
following information is a general overview.  Other documents should be consulted to provide details on 
the mechanics of the RUSLE2 program. 
 
This User’s Guide describes RUSLE2, its factors, selection of input values to compute its factor values, 
and application of RUSLE2.  The TABLE OF CONTENTS lists the topics covered by the User’s Guide.  
 
RUSLE2 is a straight forward, easily used computer program that is best learned by using it.  As you 
become familiar with the operation of the program, we encourage you to thoroughly read the User’s 
Guide on RUSLE2.   
 
Like all other hydrologic models, RUSLE2 has its limitations and its proper approach for selecting input 
values and interpreting computed values.  Before you begin to apply RUSLE2 to your own problems, you 
should become well acquainted with RUSLE2 and its factors. 
 
This User’s Guide provides instructions for application of RUSLE2.  This guide is not complete, but it 
should be sufficient for most applications.  Additional information is available in the RUSLE2 program 
itself on the HELP screens. 
 
 

ABOUT RUSLE2 
 
The structure of the revised universal soil loss equation RUSLE2 is based on the Universal Soil Loss 
Equation (USLE), which is given by:  
 

A = R K L S C P 
 
where A = average annual soil loss from rill and interrill erosion caused by rainfall and its associated 
overland flow (tons ac-1 yr-1), R = the factor for climatic erosivity, K = the factor for soil erodibility 
measured under a standard condition, L = the factor for slope length, S = the factor for slope steepness, C 
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= the factor for cover-management, and P = the factor for support practices.  A value for soil loss A is 
computed by selecting values for each factor and multiplying them. 
 
 

GENERAL USE OF THE RUSLE2 PROGRAM 
 
The RUSLE2 program is simple and easy to use.  Rill and interrill erosion at a specific site is a function 
of the weather, soils, topography, and land use at the location.  Data for variables that represent these 
factors are stored in RUSLE2 databases. RUSLE2 is run by selecting database entries to represent site-
specific conditions.  RUSLE2 then computes soil values using this information.  Most of the input values 
needed to run RUSLE2 are readily available in existing database files that are supplied with the program.  
If the necessary data are not available, the parameters used in RUSLE2 are simple so that new values can 
be easily developed. 

Erosivity (R factor) values for locations where a particular user will apply RUSLE are in a database file 
in the RUSLE computer program. RUSLE2 also uses values for the bimonthly distribution of the 
erosivity. Values used by RUSLE2 for average monthly temperatures and precipitation are available in 
the RUSLE2 data files supplied with the program or can be obtained from readily available weather 
records. 
 
Soil erodibility (K factor) values are selected from soil survey information available in field offices of the 
USDA-Natural Resources Conservation Service (NRCS).  The particular site is located on a soil survey 
map, and the erodibility of the soil-mapping unit at the site is identified and entered into the RUSLE2 
program.  If values are not available, they can be calculated using the Soil Erodibility Nomograph in the 
RUSLE2 program.   
 
Slope length, steepness, and other topographic (LS factor) values are determined from an on-site visit or 
from other topographic information such as highly detailed contouring maps.  These values are entered 
directly in the RUSLE program. 
 
Land use is the simple most important factor that determines rill and interrill erosion.  The typical 
objective in conservation planning is to use RUSLE2 as a guide in choosing a land use practice that 
controls erosion to an acceptable rate.  The effect of land use in RUSLE2 is considered in the terms of 
management practices (C factor) along with supporting practices (P factor) like contouring that is added 
to the basic management practice. 
 
Management practices refer to such things as the tillage, cropping, vegetation, and erosion control 
materials that are applied to the hillslope.  A database file for a management practice in RUSLE2 involves 
a set of dates with corresponding operations, vegetations, and residues.  Numerous management files are 
include in the management database that comes with the RUSLE2 program.  With RUSLE2, the user 
selects an existing management file, or a new one is created to represent the particular field condition.  In 
almost all cases, an existing management file can be used, but if a new one is created, it is saved for use in 
other similar applications. 
 
Operations are discrete events that change properties of live vegetation, residue, and/or the soil that affect 
rill and interrill erosion.  Examples of operations include tillage, planting, harvesting, grazing, burning, 
frost, and ripping.  Certain information used to describe operations is stored in operation files that are 
contained in a RUSLE2 operations database that comes with the RUSLE2 program.  Operations are 
selected from the operation database to describe management practices.  If an operation is not available in 
the operations database, one can be created and stored in the database for later reuse. 
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Vegetation is one of the most important factors that affect erosion.  Certain operations like those 
associated with planters and drills that seed crops call a vegetation file that represents live vegetation that 
is being considered in the application of RUSLE2.  Just like for operations, vegetation files are developed 
for the various vegetations that are encountered in RUSLE2 applications.  Several vegetations are in the 
vegetation database that comes with RUSLE2.  If the necessary file is not available in the RUSLE2 
database, a new vegetation file can be created and added to the database. 

Ground cover produced by crop residue and plant litter is the single factor having the greatest effect on 
erosion.  Plant residue is the vegetative material left after live vegetation is killed.  Such operations as 
shredding and tillage convert standing residue to flat residue and to buried residue.  RUSLE2 also track 
both live and dead roots.  Each vegetation produces residue.  Residue data files are included in the residue 
database provided with RUSLE2. A residue file is assigned to each vegetation file, and additional residue 
files can be created and saved in the RUSLE2 database. 

Residue data files are also used to describe mulch and manufactured materials applied to construction 
sites to control erosion. 
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RUSLE2 PROGRAM SETUP 
 
Create a RUSLE2 Shortcut Icon for your desktop 
 
To create a RUSLE2 Shortcut Icon for your desktop, simply  navigate to Start \ All Programs \ 
USDA Applications \ RUSLE2 \ RUSLE2 Erosion Protection.  DO NOT LEFT CLICK, instead 
Rick click your mouse and go to “Send to”, click desktop (Create Shortcut).  This will place a 
shortcut on your desktop. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remember to right 
click here. 
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Open the RUSLE2 Program 
 

A. You can open the RUSLE2 program by clicking on the RUSLE2 icon on the Desktop. 

  or   
 

OR BY 
B. Clicking on Start>Programs>USDA Applications> RUSLE2 

 
 
 
 
 
Choosing the correct template 
 
Step 1: Choose the correct template for running RUSLE2 
The following screen should appear when you fist open RUSLE2.  You want to choose the 
NRCS simple SCI & Fuel Use110206 template.  You may also choose NRCS simple SCI 
N_Leach 101506 if you prefer to display the Nitrogen Leaching Index.  Both templates are the 
same otherwise.  Once you choose this template then simply click OK.  This will set your 
RUSLE2 program to the correct template.  
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The following screen may or may not appear.  If this screen appears, click “cancel”. 
 

 
 
 
If for some reason neither of the above screens appear, simply go to the “Options” menu to 
set the correct template.  Follow the procedure below: 
 
From the toolbar menu, click on Options / Template / Load 
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When the following screen appears, choose NRCS simple SCI & Fuel Use110206.xml or you 
may choose NRCS simple SCI N_Leach 101506 (for the Nitrogen Leaching Index).  Next click 
open.  This will set you computer to the proper template. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  You do not need to set the template again each time you open RUSLE2 unless you wish to 
change it.  Your RULSE2 program will automatically default to the template you choose each 
time you open the program. 
 
 
Set your RUSLE2 Program to the Correct Database (FOR NRCS USERS 
ONLY) 
 
When RUSLE2 is installed on your computer, the program automatically creates and defaults to 
an empty database located in your C:Drive.  This database is called “moses”.  It is the database 
which stores all of your RUSLE2 data including crop rotations, managements and RUSLE2 
calculations or farm data.  For Conservation Planning and using RULSE2 you will need to re-
direct the database to another database which is located on your Shared Drive.  This will ensure 
you are working with the most up-to-date information when using RUSLE2 and that your work 
is saved to the Server each night.    
 
NOTE:  It is EXTREMELY IMPORTANT that you use RUSLE2 with the correct 
database.  Failure to use the correct database could result in loss of RUSLE2 field data. 
 
When RUSLE2 was installed on your computer, the program creates and automatically defaults 
to a “moses” database located on your C: drive.   You will need to re-direct this database to your 
S: shared “county_moses” database.  To do this simply complete the following steps: 
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Step 1:  At the top of the RUSLE2 screen click on Database, then choose Open Alternate. The 
following screen will appear.   

 
 
 
Step 2:  Click the drop down menu, navigate to your S:Drive and locate your shared “moses” 
database.  Your shared “moses” database is located at S:\Service Center\NRCS\RUSLE2.  In 
there should be your specific county “moses” database.  It should be named county_moses.   
For example:  Carroll_moses.  Click once on your county specific “moses” database and then 
click “Open”.  This will re-direct your database to the shared drive.  All existing files and 
information from your county field office that has been completed using RUSLE2 will now be 
available for your use and information. 
Note:  You do not need to import the supporting database sets such as Climate, Soils and/or 
CMZ for your area.  They are linked to your existing “moses” database in your shared drive.  If 
you choose at some point to use your C:Drive “moses” database, then you will need to import 
these supporting database sets. 
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Step 3 – Set your shared “moses” database to always open to this database 
You should now set the S: shared “moses” database to always open each time you boot up 
RUSLE2.  To do this, simply go to menu toolbar and click on Database.  Next, choose Startup 
Database.  Click once on this and it will place a check to the left of Startup Database.  This will 
ensure each time you boot up RUSLE2, you go to the correct shared “county_moses” database. 
 

 
 
 
NOTE:  ONCE YOU COMPLETE THE ABOVE STEPS, THERE IS NO 
NEED TO CONTINUE WITH THE FOLLOWING STEPS PAGES 14 
THROUGH 20 FOR IMPORTING DATABASE SETS.  ALL CLIMATE, 
SOILS AND CMZ DATABASE SETS FOR YOUR AREA ARE 
AVAILABLE FOR USE.  YOU MAY SKIP THE STEPS BELOW AND GO 
DIRECTLY TO RUSLE2 INTRODUCTION ON PAGE 21 OF THIS 
DOCUEMT. 
 
IF YOU DO NOT HAVE AN S: DRIVE SHARED “MOSES” DATABASE, 
YOU WILL NEED TO COMPLETE THE FOLLOWING STEPS ON 
PAGES 14 THROUGH 20. 
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RUSLE2 ARCHIVE FOLDERS 
 
Create a “RUSLE2_Archive” folder 
 
Create a folder in your Shared Directory which can then be used now and in the future to store all of your 
RUSLE2 files for later import and export. 
 
Note:  Your RUSLE2 Archive Folder may already be created for your office.  To check this, simply 
navigate to your shared drive under the following address:  For none NRCS users, you will create 
these folders in your C:drive.   
 
\\mdyouroffice\shared\Service Center\NRCS\RUSLE2\RUSLE2 Archive 
 
If your database files are present, you do not need to create the Archive Folder.  Database sets have 
already been downloaded.  You only need to import the database sets to your computer for use in 
RUSLE2.  If your shared folder has been created and database files are present, skip to “Importing the 
RUSLE2 Database Sets, page 9 of this guidance document, otherwise continue below:  
 
Step 1: Open Windows Explorer.  Create a folder in your S (Shared) directory at the following 
pathway:  \\mdyouroffice\shared\Service Center\NRCS\RUSLE2\RUSLE2 Archive 
The folder RUSLE2_Archive can be used now and in the future to store all the RUSLE2 files for 
later import and export files. 
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Step 2:- Next, create four folders within the RUSLE2_ Archive folder.  The first folder name 
MD_Climate_Data, the second name MD_Crop_Data, the third name MD_Soils_Data and the 
fourth name Database_Updates.  These are the folders within RUSLE2_Archive where you will 
save database sets you will need to download from the website.  These will also be used to 
import the database sets for your RUSLE2 program. 
 
 

Create 4 folders 
within 
RUSLE2_Archive 
to store Data sets 
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DOWNLOADING THE RUSLE2 DATABASES 

 
Download database files from RUSLE2 Website  
 
The following steps are needed to install the Climate, Soils, and Crop Management databases.   
 
Step 1:  Go to the website http://fargo.nserl.purdue.edu/rusle2_dataweb/RUSLE2_Index.htm.  
This site contains the “official” database sets to download and use for RUSLE2.   

 
Step 2:  Download the following from the above website and save it into your specific Data 
folder within your RUSLE2_ Archive folder.  Remember this folder is located in your Shared 
Drive under the following:   
\\mdyouroffice\shared\Service Center\NRCS\RUSLE2\RUSLE2 Archive 

 
 

1. Climate Database for Maryland.  Click on “Data Files” under Climate Data 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
- The flowing screen should appear.  At this screen double click on the MD Climate 

file and save into your RUSLE2_Archive \ MD_Climate_Data folder.  
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2. Next, download the Crop Management Zone files.  Follow the same procedure as 
the Climate Data files.  Download the Crop Management Zone(s) (e.g. CMZ 65) 
that covers your respective work area.  You may download nearby CMZ’s from 
your area depending on areas you work in.  See Figure 1 this page for a map of 
Crop Management Zones. 

3. Finally, download the Soils Database for your counties of choice.  NOTE:  The 
soils databases are county specific.  Only download the counties for which you 
will be working in.  Do not download all counties since these are large files that 
will take up unnecessary space on your computer.  This will reduce program 
processing time when using RUSLE2, although newer versions of RUSLE2 has 
seem to overcome this. 

 

 
Figure 1.  MARYLAND CROP MANAGEMENT ZONES 
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IMPORTING THE RUSLE2 DATABASES 

 
 
Import the database sets into RUSLE 
 
 
 

A. Return to Windows Explorer.  Open the RUSLE2_ Archive folder where you saved the 
Soils Database, the Climate Database, and the Crop Management Zone (CMZ) files. 

 
B. Copy the Climate database file from your RUSLE2_ Archive Folder into C:/Program 

Files/USDA/RUSLE2/import folder.  This is where the RUSLE2 import utility will look 
for this file.  Repeat this process for the county soils database(s) files and the desired 
CMZ database(s).  These are the one’s you downloaded prior to installing the RUSLE2 
program. 

 
C. Exit out of Windows Explorer and open the RUSLE2 program.  (Click on 

Start>Programs>USDA Applications>Select RUSLE2) or (Click on shortcut button.) 
 

  or   
 
D. Go to the Database Menu and Select “Import RUSLE2 databases...”  (This is the menu 

used to import your climate, soils, and crop management zone databases.) 
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E. An Import menu box will appear, and if you copied your files into the import folder, they 
should appear in the database record box.  Highlight the database you want to import as 
shown in the example below, where the Allegany County MD soils database is 
highlighted.  Click on Open. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
F. An import database menu box will appear.  Click on the folder that you are going to 

import, i.e. climates, managements, soils.  Select the database you want to import by 
clicking the folder and check the name of the database you want.  In the graphic below, 
soils have been clicked and a check has been placed in the box in front of Allegany MD.  
Make sure None is selected under Include dependent files and Import to same folder is 
selected.  Click Import. 

 

 

Make sure 
None is 

selected. 

Make sure Import 
to same folder is 

selected. 
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G. After clicking the import button, the software will start the import process and a series of 
boxes will appear and then disappear.  Click OK on Import Complete box, then click OK 
on the RUSLE2 “The import is finished” box.  Repeat these steps for each database you 
need to import. 

 
 
Note:   Climate Database: Import the entire file 
  Soils Database: Only import counties you need 

CMZ Database: Only import for areas you need.  Typically they will be 
either 65, 59, 66 and/or 4.1.  You may import all if you 
want. 

 
 
 
 

 
 

 
 

H. After the databases are imported into RUSLE2, you are ready to use the software to 
predict and evaluate sheet and rill erosion. 

 
 
 
 
YOU HAVE NOW COMPLETED THE INSTALLATION, IMPORT PROCESS AND 
DATABASE SELECTION FOR RUSLE2.  YOU CAN STOP HERE OR CONTINUE IF 
YOU WISH TO REVIEW THE PROGRAM FEATURES AND START USING RUSLE2. 

Note:  there may be one less item 
imported than selected.  This 
happens sometimes.  Import is still 
complete if this occurs. 

Click OK 
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RUSLE2 INTRODUCTION 

 
Using the RUSLE2 Program 
 

C. You can open the RUSLE2 program by clicking on the RUSLE2 icon on the Desktop. 

  or   
 

OR BY 
D. Clicking on Start>Programs>USDA Applications> RUSLE2 

 
 
Review program feature icons 
 

Plan Description View – (Green Watershed Icon) This is the template to use to calculate 
soil loss for multiple fields.  These calculations can be made for single systems or 
multiple alternatives. Use this view for whole farm conservation planning. 

 
Field Worksheet View – (Data Sheet) This is the template to use to calculate soil loss 
alternatives for one field or one slope. 

 
Profile View – (Green Sloping Line) This is the template for calculating soil loss for one 
slope or one field.  Can only be used for single systems. 
 
 

 
 
 
 
 
 

Plan Description 
View – Multiple 

Fields 

Worksheet View – 
Single Field Alternatives 

Profile View – Single Field 
Calculations 



Maryland RUSLE2 User's Guide_02/2013 
 

 22 

 
 
Review program database icons 
 
These icons below contain specific information for use when developing RUSLE2 crop rotations 
for soil loss calculations.  Before use of these below, be sure to have had basic RUSLE2 training.  
Failure to do this may result in loss of data. 

  
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
Climate 
The climate object describes the weather information for the site.  The information in this object includes 
data on annual erosivity, 10 yr EI storm, average monthly temperature, and average monthly precipitation.  
Information is cataloged in the database according to names of locations. 
 
Storm erosivity 
Storm erosivity varies through the year depending on location.  The information in the storm erosivity 
object describes how erosivity varies during the year as a function of zones or regions.  Information is 
cataloged in the database according to a zone number. 
 
Soil 
The soil object includes information on soil erodibility, soil texture, hydrologic soil group, and rock 
cover.  Also, this object includes the soil erodibility to compute a value for the soil erodibility factor if 
one is not available.  Information is cataloged in the database according to a soil name, which could be a 
soil-mapping unit from an NRCS soil survey. 
 
Management  
The management object contains information on management practices.  Each practice typically includes 
a list of dates and the operations, vegetations, and applied materials like mulch and manure associated 
with each date.  Information is cataloged in the database according to a management name chosen by the 
user. 
 

Climate Storm 
Erosivity Soil Management Operation 

Vegetation 
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Operation 
The operation object contains the information used to describe operations.  A key component of the 
information used to describe an operation is processes including begin growth, kill vegetation, flatten 
standing residue, disturb surface, remove surface cover, and remove live biomass.  Information is 
cataloged in the database according to an operation name chosen by the user. 
 
Vegetation 
The vegetation object contains the information used to describe live vegetation.  This information 
includes a name for the residue to associate with the vegetation and data on yield, the relationship of 
above ground biomass to yield, how the vegetation slow runoff, and temporally varying values on root 
biomass, canopy cover, fall height, and live ground cover.  Information is cataloged in the database 
according to a vegetation name chosen by the user. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CREATING COUNTY SPECIFIC DEFAULT TEMPALTES 
 
Note:  This step is optional.  You do not need to complete before using RUSLE2.  These 
steps simply help the user save time when working in specific counties.  If you work in 
many counties, you may skip this step unless you want default templates for areas you are 
working in. 
 

Creating county specific templates of the PLAN, WORKSHEET, and PROFILE views 
now will save you time later for each instance you need to calculate sheet and rill erosion.  
First, open the PROFILE view by doing a single left click on the PROFILE view button 
(sloping line).   
 
 

Residues Contour 
Systems 

Strip 
Barrier 

Systems 

Hydraulic 
Element 
systems 

Hydraulic 
Element 

Flow 
paths 

Deep soil 
Drain 

systems 

Irrigation 
Systems 
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The following screen will appear.  Click on the default template file and click open or 
double click on the default file.  NOTE:  Allegany County, MD, will be used in the 
following examples.  When creating your county defaults, select your appropriate county 
data, and save appropriately. 
 

 
After opening the PROFILE view, click the drop down for the location.  Double click the 
USA folder.  Then double click the Maryland folder.  Scroll through the county files and 
select the appropriate county climate data files.  Double click on the appropriate county 
file.   
 
Do the same procedure for soil type.  Click the drop down box for Soil Type.  Scroll 
through the list and select the appropriate county soil survey.  Double click on the county 
name.  Scroll through the list of soil name folders and select one (most commonly used in 
your county).  Double click on the soil folder to open and select the appropriate soil file.  
Double click on the soil file to populate the soil type box.  Procedure is shown below for 
Allegany County as an example. 

Select default file and click the open 
button or double click the default file. 
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You have created a county specific template for a PROFILE; however, it must be saved 
for future use.  Select the File menu option and scroll down to Save As and single left 
click.  (Or…you may click on the shortcut button that has a disk with a yellow label on it, 
second shortcut button from the left.)  

 
A “save objects into profile” box will appear.  Type your county name in the name box at 
bottom of the screen followed by default and press the Save button.  Example:  
Allegany_default.  You now have created a default template to be used whenever you 
need to do a PROFILE view calculation, or rotation.  The procedure is shown below. 

Double Click 
USA 

Double Click 
Maryland 

Double Click 
Allegany County 

Double Click 
Allegany, MD 

Double Click the 
folder for the most 

common soil 

Double Click the soil  
you want as default 

Notice the Allegany County Climate, and the Albright Silt Loam Soil is populated below. 
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Or… 

 
Follow the same procedure to create a county specific WORKSHEET Template.  Open the 
WORKSHEET View by doing a single left click on the WORKSHEET view button (data sheet). 

 
The following screen will appear.  Click on the default template file and click open or double 
click on the default file. 

 
 

Type in the county name followed 
by default.  Then click save. 

Save As 



Maryland RUSLE2 User's Guide_02/2013 
 

 27 

 
 

Select default file and click the 
open button or double click the 

default file.  
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Follow the same procedure to populate the location (climate data) and soils as you did for the 
PROFILE template.  Follow the steps in the following pictures. 
 

 
 

 
 
 
 
 

Double Click Allegany 
County 

Double Click 
Preferred Soil 

Notice Location and 
Soils are Populated 
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You have now created a county specific WORKSHEET template.  It must be saved for future 
use.  Select the File menu, scroll down to Save As and do a single left click or single left click on 
the Save As shortcut button on the toolbar.  A “save objects into worksheets” box appears.  Type 
the county name followed by default (for example, Alleganydefault) and press the Save button.  
You now have created a default template to be used whenever you need to do a WORKSHEET 
view.  (The procedure is the same as shown for profile.  See picture on page 24.)   
 
Follow the same procedure to create a county specific PLAN Template.  Open the PLAN View 
by doing a single left click on the PLAN view button (green watershed, looks like a leaf). 

 
The following screen will appear.  Click on the default template file and click open or double 
click on the default file. 
 

 
 
 

Select the default file 
and click the open 

button or double click 
the default file 
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Follow the procedure pictured below, which is almost the same procedure as for a PROFILE 
and/or WORKSHEET template. 
 

 
 
 

 
 
 
You have created a county specific template for a PLAN, to be saved for future use.  Select the 
File menu option and scroll down to Save As and do a single left click.  A “Save objects into 
plans” box will appear.  Type your county name in name box at the bottom of the screen 
followed by default (for example, Alleganydefault) and press the save button.  You now have 
created a default template to be used whenever you need to do a PLAN description view.   

Double click USA, Double click Maryland, and then 
Double click the desired location (i.e. Allegany County). 

Notice the location field is 
populated. 
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USING THE RUSLE2 PROGRAM  
 

 
Starting RUSLE2 
 
Open the program by clicking on Start>Programs>USDA Applications>Select RUSLE2, or by 
clicking on the shortcut button: 

  or   
 
 
 
Before you can calculate soil loss for a field or multiple fields, you must first build 
the producers crop rotation by using the Crop Rotation Management Screen.  This 
is the first step in calculating soil loss. 

 
 

 
 
Building a single or multi-year crop rotation 
 
Specific crop rotations will provide for a more accurate calculation of the RUSLE2 Soil 
Conditioning Index and Total Soil Loss.  One method of developing a multi-year crop rotation is 
provided below with step-by-step instructions.  Please note:  There are many ways to develop a 
multi-year crop rotation.  This is only one method.  I have found this to be the easiest and most 
error free. 
 
 
Step 1:   Start by thinking about what type of rotation you want to build.  Multi-year crop 
rotations are usually very similar each year with only a few minor changes associated in the 
rotation.  For this example we will build the following crop rotation: 
 
Corn – Grain, chisel plow in the fall with two diskings in the spring before 
planting. 
Wheat – disk once in the fall before planting. 
Soybeans – Double Crop after wheat, no-tilled. 
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Start by opening the Crop Rotation Management Screen (yellow folder) and double click on 
default. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2:   This will open up the Crop Rotation Management Screen.  From here, click on 
“View/Edit Rotation builder used to make this management”.  This will open up the crop rotation 
builder screen where you complete the actual build. 
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Rotation builder of default screen.  This is the screen where you complete the actual build of the 
crop rotation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 3:   Expand the Management List column of this screen so that it will be easier to build the 
crop rotation and see exactly what you are doing.  Do this by moving your cursor just above the 
Management column (a black down arrow will appear), right click and scroll down to Column 
width.  By default the program column is set to 3 cells.  Change this to 6 or 7 cells. 
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Step 4:   Next we will choose our first crop of the rotation.  Click on the Crop Management  
Zone (CMZ) of your choice and choose your first crop.  In this example we have chose CMZ 59 
/ A: folder, Single year; single crop templates / Corn / fall chisel straight shank (corn grain,fcst). 
Double click on this crop selection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 5:  Next click on the plus (+) sign under Man column to add another row to the crop 
rotation.  Note:  By default RUSLE2 makes and exact copy of the crop selected above. 
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Step 6:  Next we will choose our second crop of the rotation.  Click on the drop down menu to 
the right of Management 2.  In this example we will choose CMZ 59 / A: folder, Single year; 
single crop templates / Winter small grain / wheat w, grain; fds, Z59.  Double click on this crop 
selection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 7:  Next we will choose our third and final crop of the rotation.  Click on the plus (+) sign 
under Man column to add another row to the crop rotation.  Note:  Again, by default RUSLE2 
makes and exact copy of the crop selected above. 
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Click on the drop down menu to the right of Management 3.  In this example we have chose 
CMZ 59 / A: folder, Single year; single crop templates / Soybeans Narrow Row / soybeans, nr,nt, 
Z59.  Double click on this crop selection. 
 

 
You have now developed your multi-year crop rotation.  
  
Step 8:  Click “Apply/Close at the bottom of the Management List Screen.  This screen will 
close and take you back to the Management or Results screen. 
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Step 9:  Next we will save the rotation in your C: folder and give it a name.  You must save crop 
rotations you built in your C folder of RUSLE2.  You cannot save in any other location except 
the C folder.  See screen shots below.  For this example we will save it as Example Farm.  To 
save this rotation to your C:folder / Other local management records, first click the “Save As” 
button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next navigate to your C folder for the CMZ you wish to save the file in.  In this case, since this 
crop rotation was created using CMZ 59, so we will navigate to its C folder. 
 

 
 
 

Double Click 
on CMZ 59 
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Next, name the crop rotation.  In this example the name is “Example Farm”.  Save the rotation as 
Example Farm to your C:folder / Other local management records. 
 

 
 
 

Double Click 
on c. Other 
Local Mgt 
Records 
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Step 10:  Exit from the Management Screen.  You should now have a blank screen.   Your crop 
rotation that you built is now saved for calculating soil loss for a field/farm.  See “Applying a 
single or multi-year crop rotation for calculating soil loss” of this guidance document. 
 
 
 
Applying a single or multi-year crop rotation & 
Calculating soil loss 

 
Step 1:  In the introductory screen, click the ‘PLAN view’ shortcut button. 

 
This is the screen that can be used to calculate soil loss for multiple fields with multiple 
scenarios .  It is the screen that should be used for whole farm conservation planning.  We 
will use the ‘PLAN view’ to provide instruction on how to use RUSLE2.  The other 
calculation views (WORKSHEET and PROFILE) follow a very similar process and are also 
utilized during the PLAN view.  

 
Step 2:  Select a Starting File. 
 

In the “Open Objects From a plan” dialogue box, click on the file you wish to start.  If you 
are starting for the first time, select the county specific default.  Click Open or double click 
the file name. 

 
Step 3:  Owner Name or Client Name. 
 

Click on the drop down arrow.  A box will appear where you can type in the client name(s). 
 
Step 4:  Location.  (Other than the county specific default) 
 
If using the county specific default, then skip this step.  Click on the drop down arrow.  Navigate 
down the files, open your state, then scroll down and double click the county/climate file you 
want. 
 
Step 5:  Save this Template.  (Optional) 
 

At this point or anytime after this, you can save this template/management system so that you 
can later start with this template and the location you selected will already be entered when 
you open the template. 
 
Click File>Save As> 
In the name blank of he dialogue box, type in a name you would like to call this template.  
Click Save.  This is now saved for future use. 
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Step 6:  Info Box (Upper Right of Screen) 
 

Place your cursor in the box, click once, and then type a description of the fields or treatment 
units being evaluated.  This will be helpful information for the future.  The information 
entered here will appear in the Report Printout that will serve as your permanent record. 

 
 
Step 7:  Add Fields. (Plan View) 
 

In the box titled ‘List of fields’, click the + sign to add the number of fields that you wish to 
calculate soil erosion for.  To delete extra fields, highlight the worksheet/field row, and then 
click on the – sign.  Note:  Field names/numbers will be changed later.  (The example will 
have 4 fields.) 
 

Step 8:  Save As. (Plan View) 
 

Click on the Save As icon or on File>Save As.  Save the PLAN whatever you want to call it.  
For example, type in the client name followed by your initials.  (e.g. clientnameTP)  You will 
notice that the title bar now shows what view you are in and the name of the saved PLAN. 
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WORKSHEET VIEW 
You must now utilize the WORKSHEET view from within the PLAN view to evaluate different 
alternatives for each field.  You will later utilize the PROFILE view from within this 
WORKSHEET view to calculate the different alternatives. 
 
Step 9:  Enter Field Names and Data. (Worksheet View) 
 

In the box, ‘Fields to View’, click on the yellow folder next to the word Worksheet.  This 
will open the WORKSHEET view where you can enter the field name/number and data for 
that field.   
 

 
 
Field Name:  Click on the drop down arrow.  A text box will appear in which you can delete 
the “1” and type in the name or number of the field to be evaluated. 
 
Info box:  Click in the white box and type in any information about that field you deem 
important and may need to know in the future. 
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Soil (Other than county specific default):  Use the drop down arrow to navigate to the county 
soil database, then down to the soil map unit that best represents the field being evaluated.  
Double click on the map unit to enter.  Note:  You will need to click on the + sign in front of 
the soil folder to open that folder.  Some map units have more than one component, and you 
will need to select the map unit component that best fits your field situation. 
 
Slope Length (ft) :  Type in the measured length of slope (e.g., 150). 
 
Avg. Slope Steepness (%) :  Type in the measured slope % (e.g., 3 %). 
 
 

 
 
 
 
 
 
Save :  Click on File>Save or use the save shortcut button.             
        

Note:  Notice that when you make changes to the PLAN view, an asterisk (*) appears 
on the title bar after the name.  This asterisk lets you know that you have made 
changes to the file but have not yet saved the file.  The asterisk will disappear once 
you save the file.  Make sure that you always save if an * appears on the title bar in 
order not to lose data changes. 
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Adding or Deleting Attributes on the “Worksheet View”  
 
Some of the “attributes” e.g. diversions/terraces are not needed in your location or you may wish 
to add one to make the worksheet more useful for your location.  Attributes can be added and 
deleted at any time – if you delete on then want to add it back it can be done.  
  
To delete an attribute:  
1

st
 Click on an attribute title e.g. Cover Values.  

2
nd

 Right click and select – Delete this visual.  
  
To Add and Attribute:  
1

st
. Right click on the words “Management Alternative Table” then select Add Attr.  

2
nd

 From the choice list provide from Add Attr select the attribute you wish to add.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Description  
Type in a short description of the rotation system. The results will be shown on the Description 
will be displayed in the printout report.  

In this case, Residue Burial 
Level was added.  Once 
selected, it will appear at the 
end of the row. 

After you click the drop down arrow 
next to “Description” a blank box will 
be displayed to type in a description – 
example shown. 
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PROFILE VIEW 
 
The best way to calculate RUSLE values for the alternative crops that a producer is 
considering is to utilize the PROFILE view from within the WORKSHEET view that was 
opened from the PLAN view.  (Got it?)  The following steps outline how to do this. 
 

Step 10:  Open the Profile View. 
 

Click on the yellow folder just to the left of the word Profile in the WORKSHEET View.  
The PROFILE view will appear in another window. 
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Step 11:  Base Management (Profile View) 
 
Click on the arrow for the drop down menu on Step 4a:  Select base management.  Scroll down 
the drop down menu and double click on the appropriate CMZ.  Remember, we built the 
example crop rotation in Building a single or multi-year crop rotation.  We created a file called 
“Example Farm”.  So for this example, navigate to CMZ 59 / C folder / Example Farm.  Click on 
this to enter the crop rotation. 
 
 

 
 
 
Navigate to “Example Farm” and Double Click.  This will enter the “Example Farm” crop 
rotation in section 4a. 
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Step 12:  Complete Step 4c of profile view 
 
Step 4c allows the user to fine tune and make adjustments to crop yields based on adjustment or 
general yield level, adjust residual burial level and even account for percent rock cover.  Click on 
any of the yellow folders to adjust/modify these items.  Follow the guidelines below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Adjust Yields 
Click the yellow folder next to “Adjust yields”.  The dialogue box to adjust the crop yields will 
appear.  In this example, the corn is set @ 112, wheat @ 40 and soybeans @ 20 bu/ac.  

Type in the desired 
yields here, then 
click the red X to 
close. 

Note:  If the program will not allow a yield 
change, go back to the profile view and set 
the General Yield Level to “Set By User”. 
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Adjust Residue Burial 
Click the drop down menu to open a choice list to decrease burial or increase burial rate for each 
field operation.  Use these choices to better match the residue burial percentages for the site 
specific situations.  Note:  The selection effects ALL operations in the rotation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Adjust Rock Cover 
Click here to add the percent of the surface that meets the rock cover criteria (see the section 
“Rock Cover - Guidelines for Estimating Rock Cover in the Field”).  
 



Maryland RUSLE2 User's Guide_02/2013 
 

 48 

Step 13:  Complete step 5 of profile view 
 
Step 5 allows the user to enter any supporting practices that may be installed to reduce the over-
all soil loss and improve the Soil Conditioning Index (SCI) rating.  Supporting practices such as 
Contouring, Strips/Barriers, Diversion/terrace, Sediment basins can all be selected by clicking on 
the drop down menus to the right for each. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Contouring  
If contouring will be applied enter the appropriate choice using the “contouring” drop down 
menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use only the absolute row grades.  The row grade means the percent of grade off the contour; 
e.g. Absolute row grade of 1% means the contouring is actually on a 1% grade across the slope – 
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not on a perfect contour.  There is one choice for “On Contour”. If contouring is not used, then 
use the default “up-and-down the hill”. 
 
 
Strips/Barriers  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Guidance to select the correct strip cropping choice:  
 

Unless your slope length is longer than 200 feet, you probably only have (2) strips on the 
“Length” (L). 
 
In the choices 2 Strip rotational 0-1 means:  2 strips on the “L” and the 0-1 means the 1st 
and 2nd crop in the rotation are next to each other (this would be a two year rotation). 
In a 0-2 means the 1st and 3rd crops in the rotation are strips next to each other (this would 
be a four year rotation like such as corn-wheat-hay-hay where corn 1st year and hay are 
adjacent or wheat and 2nd year hay are adjacent to each other. 
 

 
Guidance to select Filter Strips 
 (This applies if a filter strip is located at the bottom of the “L”):  

• Two Main Choices Are Available – Actual Width or Percent of the “Length”.  
• Select the width and the type of cover.  If you do not find the exact match select a similar 

choice – most produce very similar results.  
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Guidance to select Contour Buffer Strips 
 1st Select the actual width of the buffer 
 2nd Select the number of strips in “L” 
 3rd Select the type of cover 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Guidance to select Diversion/terrace, sediment basin 
The input for the terrace object is the number of terraces on the hillslope, the grade of the terrace 
channel, and whether or not the last terrace is at the bottom of the hillslope. 

 
 
 
 

 

 

 

 

 

 

 

Guidance to select Subsurface Drainage 
Note:  This function currently does not work in RUSLE2. 
 
This completes all data entry for calculating soil loss in RUSLE2.  Next, 
review the results of RUSLE2 by reviewing the information below. 
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Results of RUSLE2 Calculations 
 
There are several items of information that RUSLE2 provides.  Some of these items are very 
important and needed for certain conservation programs such as the Conservation Security 
Program.  Soil loss, Soil Conditioning Index (SCI) and the Soil Tillage Intensity Rating (STIR) 
are just a few of RUSLE2 ratings.  RUSLE2 will also has the ability to estimate the amount of 
fuel used in the crop rotation.  Note the screens below where this information can be found. 
 
 
 
Soil Loss for Conservation Planning, recorded in tons/acre/year 
 
The soil loss for conservation planning is the average soil loss over the length of the slope, where 
partial credit is given if deposition occurs on the slope.  It is the value for slope detachment 
(mass of sediment produced on the slope) reduced by the credit given for the deposition that 
occurs on the slope.  Units (e.g. tons/acre per year) are expressed in terms of mass of sediment, 
divided by the area determined by the slope length used in the RUSLE2 computation.   
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Soil Conditioning Index (SCI)  
Click the yellow folder next to Soil Conditioning Index. 
The SCI is the Soil Conditioning Index rating.  If the calculated index is a negative value, 
soil organic matter levels are predicted to decline under that production system. If the 
index is a positive value, soil organic matter levels are predicted to increase under that 
system.  
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Average Annual Soil Tillage Intensity Rating (STIR)   
Click the yellow folder next to Soil Conditioning Index 
The STIR value is the Soil Tillage Intensity Rating. It utilizes the speed, depth, surface 
disturbance percent and tillage type parameters to calculate a tillage intensity rating for the 
system used in growing a crop or a rotation.  STIR ratings tend to show the differences in the 
degree of soil. 
 

 
 
 
 
 



Maryland RUSLE2 User's Guide_02/2013 
 

 54 

 
Track Residue and Canopy 
Click the “Track Residue and Canopy” tab to display Standing Mass, Surface Residue, Net 
Surface Cover, Net Canopy Cover and Live Biomass.  Results are displayed for all crops in 
rotation based on crop growth days.   
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Click the fuel estimator (Fuel 
pump) icon to open the Local 
price per gallon folder. 

Fuel Estimator 
RUSLE2 has the ability to calculate the amount of fuel used in the crop rotation.  Each fuel type 
along with local cost per gallon can be entered into RUSLE2.  Follow each step below to 
determine the cost per acre for fuel used in the operation. 
 
Step 1 – Update fuel cost (price per gallon) for local area 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Double click to open a list of 
fuel types. 
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Don’t forget to click “save” before you exit!  You will need to perform 
the above steps for each fuel type price you change. 

Double click the desired fuel 
type to enter your local price 
per gallon. 

Double click in the Cost, 
US$/gal and change to your 
local price per gallon. 

Click “save” once you have 
entered your local price per 
gallon. 
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Step 2 – Apply type of fuel used in Management (Rotation Build) 
 
Open the desired management folder or build a crop rotation for the producer. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you have the management folder open, you have two options to enter fuel use.  You can 
enter fuel use for all operations, or fuel use for each operation.   
Option 1 
If the producer uses a certain fuel (example: diesel) for the entire operation, simply click the drop 
down menu shown below and double click the fuel type “diesel”.  
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Option 2 
If the different types of fuel for the operation (example: diesel tractor for tillage and a gas tractor 
for planting), you will need to enter each fuel type in the Fuel Use in this Operation column. 
Hint:  Since the majority of the operation is tillage, enter the tillage fuel type in the Fuel for All 
Operations first.  Then simply go back and enter in the other fuel type under the Fuel Used in this 
Operation column.  This will save you a lot of time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Your management folder should look something like below:  Note for this example, the producer 
performs tillage with a diesel tractor and plants with a gas tractor. 
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Step 3 – View the fuel per acre use results in Plan, Worksheet and/or profile view 
 
Once you have entered the type of fuel that will be used in the management folder and you have 
applied that management folder to your RUSLE2 calculation, you can view the Fuel Cost/Acre 
in either the Plan View, Worksheet View or Profile View. 
 
Plan View 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
Worksheet View (Note: this view will display each fuel cost for each scenario) 
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Profile View 
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Other Notes/Guidelines for Using RUSLE2   
 
You may adjust almost any of the values where there is a yellow folder.  Just click on the yellow 
folder next to what you would like to adjust and you will drill down into data.  You may not save 
changes to the CMZ templates, only to local folders.   
 
In the WORKSHEET view, you may change cover values, yield, etc.   
 
In the PROFILE view, you may adjust yields by clicking on the yellow folder next to “Adjust 
Yields”, or change yields by a percentage next to “General Yield Level”.  Note:  To adjust 
yields, make sure the “General Yield Level” is set to “Set by User”. 
 
In the PROFILE view, you may also change implements for each base management by clicking 
on the yellow folder next to the management, then using drop down menus to change the 
equipment for each practice.  You may also change dates in this screen. 
 
Soil Conditioning Index rating or SCI.  If the calculated index is a negative value, soil organic 
matter levels are predicted to decline under that production system. If the index is a positive 
value, soil organic matter levels are predicted to increase under that system.  
 
Soil Tillage Intensity Rating or STIR. It utilizes the speed, depth, surface disturbance percent and tillage 
type parameters to calculate a tillage intensity rating for the system used in growing a crop or a rotation.  
STIR ratings tend to show the differences in the degree of soil disturbance between systems.  The kind, 
severity and number of ground disturbing passes are evaluated for the entire cropping rotation as shown 
in the management description. 
 
Soil Loss for Conservation Planning (t/ac/yr):  This is the figure to use for conservation 
planning which measures the tolerable soil loss expressed as average annual soil loss in 
tons/acre/year. 
 
Sediment Delivery (t/ac/yr):  Soil loss on “L” minus what is deposited within the “L”. 
 

DELETING CREATED PROFILES, WORKSHEETS, AND PLAN VIEWS  
 

On the menu toolbar, click Database, scroll down and click Rearrange.  Click on the database 
choice you want to delete objects from, i.e., profiles, worksheets, or plans.  Then go to the screen 
on the right, right click on the file you wish to delete, scroll down and left click on delete.  Then 
confirm by clicking Yes and the file will be removed from the list. 
 
You can also open up the file, go to the menu toolbar, click File and then scroll down to delete.  
RUSLE2 will ask you if you are sure you want to delete this file.  Click “yes” to delete. 
  

 
Be certain that you want to delete before hitting the yes button.  There is no 
way to retrieve a deleted file. 
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ROCK COVER - Guidelines for Estimating Rock Cover in the Field  
 
 
Rock Cover - Guidelines for Estimating Rock Cover in the Field   
  
Introduction:  The RUSLE2 computer program has an input box on the Profile view screen for 
“Rock cover, %”.  This document offers guidelines for making estimates in the field for the 
percent cover from rock, rock fragments, or coarse fragments.  Coarse fragments on the soil 
surface effect the Cover and Management factor in RUSLE2.  Rock cover does not effect the 
Soil Erodibility factor.    
  
Caution - Use Good Judgment: Research data shows that the presence of rock cover can 
significantly reduce soil erosion, and the RUSLE2 model accounts for this effect.  However, 
users should be cautioned to exercise good judgment when developing conservation planning 
alternatives that reflect the presence of surface rock fragments.  For example, a rock cover entry 
in RUSLE2 that reduces soil loss to acceptable levels should be re-considered if the hillslope 
shows clear evidence of severe, active erosion.  
 
  
RUSLE2 uses the Kf (rock free) soil erodibility factor. 
If surface rock fragments are present and not entered, erosion is over predicted. 
 
RUSLE rock fragments are defined as those greater than 3/8 of an inch in size. 
The mean in Maryland soils is about 11 percent by volume. 
 
The following are guidelines to use in RUSLE2, if the surface rock fragment cover is not 
measured in the field.  
 
Surface Texture Modifier Rock Fragment Content 

Range 
Amount to use if no 
field measurement  

No Texture Modifier 0-15 3 
channery, shaly, gravelly, 
cobbly, cherty, flaggy 

15-35 15 

very channery, very shaly, 
very gravelly, very cobbly, 
very cherty, very flaggy 

35-60 35 
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Guidelines for Estimating Soil Erosion with Ridges and Beds 
 

With Additional Notes on Sediment Delivery and Plastic Mulch 
 
 
Ridges and Beds, Defined for Purpose of RUSLE2 Applications 
For the purpose of RUSLE2 application, ridges are a series of reoccurring ridges and furrows left 
by tillage implements such as chisel plows, hippers and disk hillers.  The top of these ridges are 
not flat for any appreciable length.  Beds, for the purpose of RUSLE2 application, differ from 
ridges in that the raised areas (top of the beds) are commonly several feet across the top, and 
must be at least one foot wide across. 
 
 
Representing Beds Using RUSLE2 
RUSLE2 does not calculate soil loss in the furrows of these beds.  Therefore, the 
topographic inputs must represent the flow path across the bed, then down the side of the 
bed to the furrow. 
 
This implies that either 1) RUSLE2 provides reasonably good erosion and sediment yield results 
when minimal erosion occurs in furrows because of high residue cover in the furrows or low 
furrow grades; or 2) the furrow carries excessive runoff and experiences excessive erosion, a 
process more closely resembling concentrated flow erosion, a process that RUSLE2 does not 
currently model. 
 
When Beds are Generally Up-Down the Hillslope:  
Represent the cross-section from the middle of one bed to the middle of the next bed.  The 
RUSLE2 output represents runoff and erosion from the middle of the bed to the furrow.  
Typically, water does not run along the top of the bed for any appreciable length, and instead 
will run off the side and into the furrow.  In the table below, the top of one bed is represented 
with a 1% grade and 2-ft length, and the sideslope of that bed is represented with a 50% grade 
and 1-ft length.  The adjacent bed across the furrow is represented with similar, but negative 
values. 
 
SEGMENT STEEPNESS (%) LENGTH (ft) 

1 1 2 
2 50 1 
3 -50 1 
4 -1 2 

 
When Beds are On or Near the Contour:   
Represent the flow path across a bed and down the bed’s sideslope to the furrow.  An 
example is illustrated in the table below in which runoff across the top of the bed is represented 
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with a 2% grade and a 4-ft length; and runoff down the bed’s sideslope to the furrow is 
represented with a 50% grade and 1-ft length. 
 
SEGMENT STEEPNESS (%) LENGTH (ft) 

1 2 4 
2 50 1 

 
 
 
Representing Ridges Using RUSLE2 
Represent the topography up-and-down the hillslope in the path the runoff would follow if 
the soil surface were flat (as if ridges were not present).  If the ridges are on contour/near 
contour, select the row grade from the drop-down menu for Contouring.  
 
NOTE:  The science in RUSLE2, in most instances, is adequate to represent ridge-furrow 
systems because it is based on research data on ridge-furrow systems with a “normal spacing.” 
But RUSLE2 does not adequately represent “abnormally” wide beds, and the subsequent wider 
spacing of furrows because runoff comes from a larger area on the bed and flow concentrates in 
the furrow. 
 
A Ridge factor built into RUSLE2 “enhances” erosion when ridges are up-down but 
“diminishes” it with contouring.   
 
Sediment Delivery in Furrows 
RUSLE2 will model sediment deposition in the furrow resulting from low channel grade, 
but not deposition resulting from increased roughness such as from high residue in the 
furrow.  Currently we have no way of modeling the channel shape and roughness, and the 
effects of different residue levels in the furrow compared to the ridge or bed.   
 
In eroding landscapes, furrow grades are often too steep for deposited sediment to remain in the 
furrows.  Therefore the sediment delivery value is the same as the soil loss value.  However, if 
the furrow grade is sufficiently flat (often associated with low runoff and/or residue in the 
furrow), sediment delivery to the end of the furrow will be less than the soil loss value. 
 
 
Plastic Mulch on Beds and Ridges 
Select the Plastic Mulch Application Operation that best represents the percent cover 
provided by the plastic mulch to the field.  So, the estimate of percent cover must include the 
furrow areas as well as the beds or ridges. 
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GUIDELINES FOR MANURE ADDITION 
 
RUSLE2 describes the effect of manure additions to soil by considering how much biomass is 
incorporated and how much is left on the surface.  The solids of the material left on the surface are treated 
as ground cover subject to decay.  The organic material incorporated is treated like incorporation of crop 
residue and is subject to decay.  Knifing manure into the soil is treating as a soil disturbance that is 
described in the same way that a tillage operation is described.   
 
When manure is placed directly into the soil by injection (knifing), the manure is placed in the lower one 
half of the depth of surface disturbance used to inject the manure.  The concentration of the manure is 
zero at one half the depth, maximum at three quarters depth, and zero at the depth of the disturbance.  
Subsequent tillage operations can bring some of the manure to the soil surface depending on the nature of 
the subsequent tillage operations. 
 
Manure can be added to the surface and later be incorporated with an operation like a tandem disk.  Four 
types of animal manure have been identified and are grouped according to their relative rates of decay.  A 
group having a fast decomposition rates includes poultry litter and municipal sewage; one having a 
moderate rate includes beef, swine and dairy lagoon wastes; one having a moderately slow rate includes 
beef, swine and dairy manure from open lots or buildings; and one having a slow decomposition rate 
includes straw and wood shavings.   
 
Manure is treated as a residue in RUSLE2, and values for the properties for manure are entered in the 
residue database.  Add manure to a crop rotation in the management screen of RUSLE2.  Enter the 
manure operation in the operations section, then choose the type of manure under “External Residue”.  
Next, open the external residue choice (click yellow folder next to residue type) and choose the correct 
amount of residue applied.  Amounts are listed by coverage vs. mass.  See below. 
 
How to incorporate manure into Crop Management File 
When manure application is included in the operation of the Crop Management File you will 
need to include the manure operation.  When you select the manure operation in RUSLE2 a 
dialog box will appear to the right of the operation that requires you to include the type of 
manure that you are applying.  
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RUSLE2 requires that inputs for the amount of manure added to a field be input as mass/ac dry 
weight. A method to convert the fresh or wet weights of manure to dry weight is shown below.    

Laboratory data should be used in lieu of these conversion methods where available.  
Moisture content estimates are also available in the Ag Waste Handbook for various 
manure classes.    

There are some new RUSLE2 manure residue effectiveness guidelines for liquid, slurry, semi-
solid and poultry manure types that only 50% of the dry weight for these wet manure types 
should be used. Liquid, slurry, semi-solid, and poultry manure types are not as affective in 
retarding the erosion process as solid manures.  RUSLE 2 users should enter only half of the dry 
weight computed for these manure types.  Use 100 % of dry weight calculated for solid manure 
and solid manure plus bedding.  

Equations to Convert to Pounds Dry Matter  

(A) For liquids and slurries  
(gals /ac) X (8.34 lbs/gal) X (% solids as a decimal) = lbs dry matter   

Sample calculations:  
(10,000 gal /ac) X (8.34 lbs/gal) X (0.02) = 1668 lbs/ac dry matter   
RUSLE2 Conversion: 1668 lbs/ac dry matter X 0.5 = 834 lbs/ac 

 
(B) For semi-solids  
(lbs /ac) X (% semi-solids as a decimal) = lbs dry matter   

Sample calculations: 
(8000 lbs /ac) X (0.15) = 1200 lbs/ac dry matter    
RUSLE2 Conversion: 1200 lbs/ac dry matter X 0.5 = 600 lbs/ac 
 
(C) For solids  
(lbs /ac) X (% solids or semi-solids as a decimal) = lbs dry matter   
 
Sample calculation:  
(8000 lbs /ac) X (0.55) = 4400 lbs/ac dry matter  
 
 
 

Recommendations for Types of Manure in RUSLE2 Database:  
“Manure, liquid” (swine from confinement, holding ponds and municipal sewage): Use Equation A,  
“Manure, semi-solids” (includes beef, swine and dairy settling basin): Use Equation A  
 “Manure, open lots” (beef, swine, dairy manure from open lots and buildings and poultry manure): Use 
Equation B,  
“Manure, solids or with bedding” (horse, sheep packs including straw and shredded newspaper): Use 
Equation C  
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Summary of % Moisture Content Manure  
Source:  Agricultural Waste Management Field Handbook.  

      
Species   % Moisture Content    % Solid Content 
 
Dairy 
Milk House     99.7%       0.3% 
Milk House + Parlor    99.4%       0.6% 
Milk House + Parlor + Holding area 99.7%      0.3% 
Anaerobic lagoon – Sludge   90.0%      10.0% 
Anaerobic lagoon – Supernatant  99.75%     0.25% 
Aerobic lagoon – Supernatant  99.95%     0.05% 
  
Beef 
Unsurfaced lot    45.0%      55.0% 
Surfaced lot - High forage   53.3%      46.7% 
Surfaced lot – High energy   52.1%      47.9% 
Feedlot runoff pond – Sludge  82.8%      17.2% 
Feedlot runoff pond – Supernatant  99.7%       0.3% 
 
Swine  
Storage tank under slats  

Farrow    96.5%       3.5% 
Nursery    96.0%       3.0% 
Grow/Finish    91.0%       9.0% 
Breeding/gestation   97.0%       3.0% 

Anaerobic lagoon – Supernatant  99.75%     0.25% 
Anaerobic lagoon – Sludge   92.4%      7.6% 
Feedlot runoff water    98.5%      1.5% 
Feedlot settling basin sludge   88.8%       11.2% 
 
Poultry  

Litter 
Layer high-rise   50.0%      50.0% 
Broiler     24.0%      76% 
Turkey     34.0%       66% 
Broiler breeder    34.0%      66% 

 
Anaerobic lagoon   

Layer – Supernatant    99.5%       0.5%  
Layer – Sludge    86.9%       13.1% 
 
Veal As Excreted    97.5%       2.5% 
Sheep As Excreted    75.0%      25% 
Horse As Excreted    78.0%       22% 
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GUIDELINES FOR IRRIGATION 
 
RUSLE2 cannot be used to compute soil loss from surface irrigation, but it can be applied to surface 
irrigated land to compute soil loss from natural rainfall.  Since irrigation leaves the soils wetter and 
thus produces more runoff from natural rainfall than without irrigation, the permeability code in the 
soil erodibility nomograph can be adjusted one step to a less permeable soil.  However, in climates 
where little rainfall occurs during the irrigation season, this adjustment is unnecessary. 
 
The other consideration given to surface irrigated land is that these lands are frequently graded to 
produce long gentle slopes.  Slope lengths for these fields can be much longer than slope lengths on 
similar fields that have not been graded. 
 
There are three ways to enter irrigation.  Rate, Depth and Monthly.  All values are entered in the 
Management Screen.  See below for each. 
 
 
Enter irrigation application by rate 
To enter the irrigation application by rate, you will need to choose the amount of irrigation in inches 
on a per day basis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter irrigation application by Depth 

First, click the drop 
down menu and 
choose the correct 
method of application 

Next, click the yellow folder.  
Enter the date of application 
along with amount (in inches) 
of water applied.  Note: click 
the + (plus) sign for 
additional dates 
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By entering the irrigation application by Depth, you can bracket the irrigation period.  See example 
below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter irrigation application by Month 
This method allows the user to enter the total amount of irrigation for the crop in inches on a month to 
month basis.  See below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First, click the drop 
down menu and 
choose the correct 
method of application 

Next, click the yellow folder.  
Enter the irrigation amount 
(in inches) by period.  Note: 
click the + (plus) sign for 
additional dates 

First, click the drop 
down menu and 
choose the correct 
method of application 

Next, click the yellow folder.  
Enter the irrigation amount 
(in inches) by month for each 
crop. 
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HELP SCREENS  
 
Version 2 of RUSLE has been outfitted with various help screens to aid the user when 
developing soil loss calculations.  To access the help screens, follow the example below.  
Note:  Help screens are currently NOT available for several areas of RUSLE2.  These are in 
process of being developed and will come available in future versions.  Help screens that are 
available can be viewed in any screen.  To access a help screen follow the steps below. 
 
For this example, the Profile View is used 
Base Management Help 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following help screen will appear. 
 
 
 
 
 
 

First, left click on the section 
you would like help on.  In this 
example, we chose Base 
Management.  Right click and 
then left click on “Help” 
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PRINTING AND SAVING REPORTS  
 

After you have completed data entry and the results are displayed in either the 
WORKSHEET, PLAN, or PROFILE view, you can print the results for viewing and saving as 
a permanent record.  The record can be saved anywhere in your file directory.  For NRCS 
users, it is suggested you save the file in the client’s customer folder within the Toolkit 
directory. 
 
Note:  The instructions below can be used for either the WORKSHEET, PLAN, or 
PROFILE view. 
 

Step 1:  Click on File on the menu toolbar.  Select Print Report. 

 
Step2:  After the dialogue box appears, select the appropriate template.  See Appendix 1 for 
examples of each printout.  Note:  The  PROFILE Record Expanded.dot version should rarely 
be used because it is a 3 page printout for a single year crop with entirely too much 
information for the average conservation plan. 

Choose a print template that will display the SCI and STIR value.  For example in Plan View, 
choose NRCS RUSLE2 Plan Record with SCIand STIR. 
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Step 3:  Click open in the dialogue box.  This will open MS Word and display your record of 
results. 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4:  At this point, you have the option of printing and/or saving the document in your file 
directory.  If you want to save this RUSLE2 run, click the File menu, and do a Save As.  Give 
it a name and Save.  If you list the proper path, this can be saved in the land user’s file in 
Customer Service Toolkit. 
 
 
 

MANAGING FILES AND FOLDERS 
 
There are several ways to manage your RUSLE2 files and folders.  Whichever way you 
decide, you should consult with your field office staff to ensure all understand the 
management system.  Since each field office shares the same “moses” database and have 
access to all files and folders in this database, care should be taken to ensure all users 
understand exactly how the RUSLE2 data is stored.  This section does not provide you with a 
system of management for your files and folders, it has only been developed to aid the user on 
how to develop a management system. 
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Managing files and folders in RUSLE2 
RUSLE2 Farm Information 
Each view of RUSLE2 (Profile, Worksheet and Plan view) have a separate folder system for 
managing files.  These sections are designed to only store your farm/field information for the 
farms you are working with.  They DO NOT store your management folders or crop rotations 
you have developed.  Although these are linked to your farm/field folders, they are saved in a 
separate location. 
Note:  All above information is saved or located in your “moses” database.  This guidance is 
developed to inform you how these are files are saved and how to manage the files. 
 
Saving files and folders in Profile, Worksheet or Plan view 
 
Step 1:  Open the Database/Rearrange folder.  Do this by clicking on Database in your 
toolbar.  Next click on “Rearrange”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The following screen will appear. 
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Step 2:  Create your folders and subfolders 
You can create folders and subfolders for Profile, Worksheet and Plan view of RUSLE2.    In 
this example, we will create a CSP folder in Profile view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note the folder now created called CSP 2006.  In this folder you can store all of the CSP 2006 
files which were developed in Profile view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First, left click on the + (plus) 
sign next to Profile.  This will 
open the folder.  Next, right 
click and go to New Folder. 

Next, left click on New Folder.  
This will create a new folder.  
You can then name the folder.  
For this example, I called the 
file CSP 2006. 

Click “Close” when finished 
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Note the created folder in the Profile view save screen.  You can create these types of folders 
in Worksheet and Plan view as well. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Saving files and folders for built crop rotations 
The management (yellow clipboard) folder is where all of the crop rotations you build are 
stored.  Remember, you can ONLY save crop rotations you build in the C: folder of each 
CMZ.  You can create subfolder in the C:folder (Other Local Mgt. Records) for each CMZ by 
following the same steps as above.  Note below the CSP 2006 management (crop rotation) 
folder created. 
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ADVANCED USERS  
 
This section is should only be used by advanced users of RUSLE2.   
 
 
Modifying a Crop Rotation in RUSLE2 
 
Overview:  Pre-built crop rotations can be modified in RUSLE2 to provide the user with 
additional flexibility in determining a more accurate soil loss or soil conditioning index. 
Modifying the existing crop rotation will allow the user to make changes to the rotation 
without over-writing this existing rotation.   
 
Note:  Modification of crop rotations should ONLY take place in Profile View of the 
RUSLE2 program.  Use the following steps in Profile View to modify a crop rotation: 
 
 
 
Step 1 – Start by opening RUSLE2 with a blank screen.  Since all RUSLE2 views are linked 
together, you can change an existing crop rotation within Plan View, Worksheet View or 
Profile View.  However, you will need to perform the actual crop rotation modification in 
Profile View. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Crop rotations can be changed in 
Plan, Worksheet or Profile View, 
however the actual rotation must be 
modified in Profile view 
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Step 2 – For this example, we will modify an existing crop rotation in Profile View.  Open 
Profile View and complete steps 1 through 3 in Profile View.   
 
Note:  Make sure you save your file to another name.  Do not write over your default 
screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 3 – Next, complete Step 4a by choosing a base management.  For this example we will 
choose crop rotation Corn grain, fall chisel straight shank; Soybeans, narrow row, fall disk.  
(cg, fcst; sb, nr, fdt).  You will need to choose your own crop rotation from your C: folder.  
This is pre-built crop rotation I chose already existed in Crop Zone 59 under my C: folder; 
Other Local Mgt. Records. 
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AT THIS POINT, CLICK THE SAVE ICON AND SAVE YOUR DOCUMENT 
 
 
Step 4 -  After choosing the pre-built rotation, open the Rotation Management folder for this 
crop rotation by clicking on the “Yellow” folder next to Base Management.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you click on the “Yellow” folder the Crop Rotation Management Screen will appear. 
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Step 5 – You can modify any aspect of the Crop Rotation within the Crop Management 
Screen.  For this example we will change Corn grain, chisel, straight point to Corn grain, 
chisel, twisted shovel.  We will also remove one of the scheduled tillage practices for disking 
of Corn. 
 
Click the drop down for Corn grain, chisel, st pt. and change to Corn grain, twisted shovel by 
double clicking on Chisel, twisted shovel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, under Corn grain we will remove the Disk, tandem light finishing.  To do this, highlight 
the line Disk, tandem light finishing, right click and choose Delete rows.  This will remove 
the entire line. 
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NOTE:  AFTER COMPLETING THIS STEP, DO NOT SAVE THIS ROTATION.  IF 
YOU DO YOU WILL OVERWRITE YOUR EXISTING ROTATION. 
 
Step 6 – Move the Crop Management Rotation Screen to the left by moving your cursor on 
the top of the Crop Management Screen, left click, hold and move the screen.  This will allow 
you to access the Apply rot. Builder Manag. Icon in Profile View.  This is where you will 
apply the modified or changed rotation. 
 
 
 
 
 
 

 
 
 
 
 
Step 7 – Apply the modified crop rotation by clicking the “Apply” icon next to Apply rot. 
Builder Manag.  This will apply the changed rotation to your profile screen. 
 
 
 
 
 
 
 
 
 

Left click your mouse at the top 
of this screen and hold to move 
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Within the profile screen, a box will appear entitled Rename cloned file.  By default, 
RUSLE2 will automatically give it a new name with an associated number (#).  In this 
example I renamed the file to reflect corn grain, fall chisel twisted shovel and removal of one 
disking practice.  You can name the rotation whatever you like.  Once you name the file, click 
“OK”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 8 – Click “OK” under Rename cloned file to apply the rotation to your profile.  Notice 
the name under Base Management.  It is now called temp/cg, fctw, 1sds; sb, nr, fdt, Z59#2. 
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At this point you have the option to save the modified crop rotation to use at a later date or 
simply keep the modified crop rotation in this Profile View only. 
 
To save the crop rotation 
If you choose to save the crop rotation, RUSLE2 will create a “temp” folder in the 
Management Builder screen (yellow folder) to store the modified rotation.  To save the 
rotation, follow Step 9. 
 
Step 9 – To save the modified crop rotation, click the “Save” icon next to Save temp. 
management as perman.   This will bring up a box entitled “Save object into managements”.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you wish to use the name indicated below, simply click “Save”.  If you wish, you can 
change the name and then click “Save”. 
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Step 10 – Once you have saved the rotation, you will need to minimize the Profile screen and 
exit out of the Management Screen.  RUSLE2 will ask you if you wish to save or overwrite 
the existing rotation.  MAKE SURE YOU CLICK “NO”. 
 
Note:  If you do not exit out of the Management Screen first and try and save your 
Profile, RUSLE2 may kick you out of the program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you exit out of the Crop Management Screen, you can now save your Profile and 
continue with your RUSLE2 soil loss calculation. 
 
Complete steps 4c through 5 to finish the RUSLE2 soil loss calculation. 
 
Note:  If you plan to use the modified Crop Rotation again, it is located in a file called 
“Temp” in your Crop Management folder (yellow folder).  Simply click on the yellow folder 
icon, double click on “temp” and your modified crop rotation should be there. 
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Updating the “moses” database 
 
About every two to three months you should update your S: shared “moses” database.  The 
“moses” database is basically the heart of the RUSLE2 program.  The “moses” database is 
periodically updated from your State Agronomist and posted to the RUSLE2 website.  This 
database contains all managements including crop tillage, planting, harvesting, crops and 
supporting practices such as contouring, strips/barriers and diversions.  It is VERY important 
to keep this database updated with the latest managements to ensure accurate RUSLE2 
calculations.  Each field office has been assigned a person who will be responsible for 
keeping the database updated.  Consult with this person to verify this has been done or follow 
the instructions below to update your S: shared “moses” database. 
 
Note:  You should have your “moses” database set to the S (Shared Drive).  The path should 
be set to S:\Service Center\NRCS\RUSLE2\county_moses.   
PERFORMING THESE STEPS WILL NOT OVERWRITE YOUR EXISTING 
DATABASE, HOWEVER THIS MAY UPDATE YOUR UNDERLINING DATA FOR 
CROPS, MANAGEMENT PRACTICES, ETC... 
 
Step 1:  Download the Database Update File from the RUSLE2 website 
Go to the website http://fargo.nserl.purdue.edu/rusle2_dataweb/RUSLE2_Index.htm.  Next, 
under Base Database & Misc Files  click on Download File 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Maryland RUSLE2 User's Guide_06/2008 

85 

 
 
Double click on the Folder Latest Base Database Updates.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the latest file in this folder.  NOTE:  There should be only one file here with a name 
such as the following:  NRCS_Moses_updates030104to080105.gdb.  Right click and select 
Copy to Folder 
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Step 2:  Copy the file directly into your RUSLE2 Archive Folder on your shared drive under 
Database_Updates.  You should store your database update files in this location. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 3:  Once the file is copied, open the RUSLE2 program.  Go to Database and select 
Import RUSLE2 database 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 3: Open the 
Database dialog and 
select import RUSLE2 
database…… 
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Step 4:  Navigate to the Rusle2 folder where you saved the update file.  Again, it should be 
located at \\mdyouroffice\shared\Service Center\NRCS\RUSLE2\RUSLE2\Dabase Updates.  Select 
the database update file you recently saved there.   Click Open. 
 

 
 
Step 5:  Once the database import screen appears, click the upper most box to auto select the 
contents of all subfolders.  Click “None” under Include dependant files.  Make sure Import 
to same folder is clicked also.  Next click “Import”.  All folders need to be checked since 
there are updates in many areas of RUSLE2  that need to be imported into your database. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click “None” under 
Include dependant 
files and “Import to 
same folder”, Then 
click “Import”. 

Click in this box to 
place a “check”.  
This will select all 
subfolders for 
importing. 
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When the “Warning” box appears click OK  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Let the import process run its course.  Be patient. This may take a few seconds.  Do not click 
the mouse or click cancel. 
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If any Confirm Object Replace message appears, choose “Yes to all”.  This may or may not 
appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When the Import Complete Box appears, click OK. 
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Click “OK” to acknowledge the import is complete and to close the import process. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You are now finished and can resume using RUSLE2 with your updated database. 
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APPENDIX 1 
Example Print Screens 

Using Word 
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RUSLE2 Profile Erosion Calculation Record 
 
Info:    
 
File:   profiles\Alleganydefault 
 
Inputs: 
Location:   Allegany County  
Soil:   ALLEGHENY silt loam 100%  
Slope length (horiz):   150 ft 
Avg. slope steepness:   6.0 % 
 
Management Vegetation Yield units Yield (# of units) 
    
 
Contouring:   a. rows up-and-down hill  
Strips/barriers:   (none)  
Diversion/terrace, sediment basin:   (none)  
Subsurface drainage:   (none)  
Adjust res. burial level:   Normal res. burial  
 
Outputs: 
Soil loss erod. portion:   34 t/ac/yr 
Detachment on slope:   34 t/ac/yr 
Soil loss for cons. plan:   34 t/ac/yr 
Sediment delivery:   34 t/ac/yr 
 
Crit. slope length:    
Surf. cover after planting:   0 % 
 
Date Operation Vegetation Surf. res. cov. after op, % 
11/1/0 Chisel, sweep shovel  0 
5/1/1 Cultivator, field 6-12 in sweeps  0 
5/5/1 Chisel, st. pt.  0 
10/10/1 Harvest, killing crop 50pct standing stubble  0 
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RUSLE2 Worksheet Erosion Calculation Record 
 
 
Info:    
 
Inputs: 
Tract #:   A1234  
Owner name:   John Doe  
Field name:   1  
 
Location:   Allegany County  
Soil:   ALLEGHENY fine sandy loam 100%  
Slope length (horiz):   150 ft 
Avg. slope steepness:   6.0 % 
 
Outputs: 
Management Contouring Strips / 

barriers 
Diversion/terrace, 
sediment basin 

Soil 
loss 
erod. 
portion, 
t/ac/yr 

Soil 
detachment, 
t/ac/yr 

Cons. 
plan. 
soil 
loss, 
t/ac/yr 

Sed. 
delivery, 
t/ac/yr 

a. Single Year/ 
Single Crop 
Templates\corn, 
grain\Corn, 
grain; fcst, z65 

a. rows 
up-and-
down hill 

(none) (none) 30 30 30 30 

 



Maryland RUSLE2 User's Guide_06/2008 

94 

 
 

RUSLE2 Erosion Calculation Record 
 
Owner name:   Type client name here.     
 
Info:   Type information here about the farm or treatments being evaluated.  This information will 
appear in the "plan summary report" which will be viewed by the client.  
 
File:   plans\ClientNameTP 
Access Group:   R2_NRCS_Fld_Office 
 
Inputs: 
Location:   Allegany County  
 
Results: 
Field name Description Cons. plan. soil loss, 

t/ac/yr 
Sed. delivery, t/ac/yr 

1 Same crop rotation with 
contour farming on 
perfect row grade, 50 foot 
cool season filter strip, 
and one diversion in 
middle of slope. 

2.9 0.98 

2 corn silage with spring 
manure, no tillage 

1.6 1.6 

3 corn grain, fall plow 4.4 4.4 
4 corn grain, strip tillage, 

wide row 
0.40 0.40 
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Rusle Program Version: Sep 22 2003 
Rusle Science Version: 8/13/2003 

Data Base: moses 

 
RUSLE2 Erosion Calculation Record#2 

 
 
File:   plans\ClientNameTP 
Access Group:   R2_NRCS_Fld_Office 
 
Inputs: 
Owner name:   Type client name here.     
Location:   Allegany County  
Info:   Type information here about the farm or treatments being evaluated.  This information will appear in the "plan summary report" which will be 
viewed by the client.  
 
Field name Soil Slope T Value, t/ac/yr Slope length, ft Slope steepness, % 
1 Allegany, MD\AbB 

ALBRIGHTS SILT LOAM, 
0 TO 8 PERCENT 
SLOPES\ALBRIGHTS silt 
loam 95% 

4.0 150 6.0 

2 Allegany, MD\AlA 
ALLEGHENY SILT LOAM, 
0 TO 3 PERCENT 
SLOPES\ALLEGHENY silt 
loam 100% 

5.0 150 6.0 

3 Allegany, MD\AlA 
ALLEGHENY SILT LOAM, 
0 TO 3 PERCENT 
SLOPES\ALLEGHENY silt 
loam 100% 

5.0 200 3.0 

4 Allegany, MD\AlC2 
ALLEGHENY SILT LOAM, 
8 TO 15 PERCENT 
SLOPES, MODERATELY 
ERODED\ALLEGHENY 
silt loam 100% 

5.0 150 6.0 
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Results: 
 
Field name Management Contouring 

system 
Support 
practices 

Terrace/diversion 
system 

Cons. plan. 
soil loss, 
t/ac/yr 

Sed. delivery, 
t/ac/yr 

Surf. cov. 
after planting, 
% 

1 temp\Corn, grain; 
fcst, soybean,nr,fcsw 

c. perfect 
contouring no 
row grade 

Filter 
strips\Actual 
width\50-ft 
Cool season 
grass filter 
strip 

1 Diversion 
0.05% grade in 
middle of RUSLE 
slope 

2.9 0.98  

2 CMZ 65\a. Single 
Year/ Single Crop 
Templates\corn, 
silage, spring 
manure\bedded\Corn, 
silage, smanb;  nts, 
z65 

a. rows up-
and-down hill 

 -- none --  -- none -- 1.6 1.6 75 

3 CMZ 65\a. Single 
Year/ Single Crop 
Templates\corn, 
grain\Corn, grain; fp, 
z65 

a. rows up-
and-down hill 

 -- none --  -- none -- 4.4 4.4 2.4 

4 CMZ 65\a. Single 
Year/ Single Crop 
Templates\corn, 
grain\Corn, grain; nts, 
z65 

c. perfect 
contouring no 
row grade 

 -- none --  -- none -- 0.40 0.40 61 
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APPENDIX 2 

Manure, Tillage and Planting Operations 
Naming Codes and Abbreviations 
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Manure Operations Naming Codes and Abbreviations 

 
 
The following is a list of manure operation codes and abbreviations in bold, used in the 
preparation of crop templates for the crop management zones, 59, 65, 4.1 (Intermediate 
Planting Dates), and 66.  Listed below the manure types are the codes that are part of the crop 
template name for all templates where manure is used.  The spreaders are specifically selected 
because of the properties included in the data bases.  The manure types were selected to 
represent the most common types of manure used in each of the multi-state CMZs.  The 
decomposition rates, which are included in the data bases.  You can see the difference on the 
average as to the actual dry matter that is applied.  Dry matter applied rates are based on 
average N and P based nutrient management plan rates for typical yields of grain and silage 
corn. 
 
 
 

MANURE TYPE MANURE SPREADER LBS. DRY MATTER 

LIQUID  1000 

manl Liquid spreader (50% infiltration) 6000 gal @ 2% dry matter 

maninjhd Injector – high disturbance 30” (50%) 6000 gal @ 2% dry matter 

maninjld Injector – low disturbance 15” (30%) 6000 gal @ 2% dry matter 

 

MANURE, MODERATE BEDDING 3000 

manb Manure spreader, solid & semi-solid 6 tons @ 25% solids 

 

MANURE, POULTRY  3000 

manp Manure spreader, solid & semi-solid 6 tons @ 50% solids 

 

MANURE, SEMI-SOLID & SLURRY 3000 

manss Manure spreader, slurry 

10 tons @ 15% solids or 
5000 gal @ 7% solids 
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Tillage Operations Naming Codes and Abbreviations 

 
 
The following is a listing of tillage operation codes and abbreviations used in the preparation 
of crop templates for the crop management zones.  Below the tillage types, are the codes and 
abbreviations in bold, i.e., fp, that are part of the crop template name.  Primary tillage types 
are listed.  Under the secondary tillage, are the operations used in preparation of the crop 
templates.  A listing of the same piece of equipment more than one time indicates more than 
one pass over the field with that implement. 
 
 
 
 
 

CLEAN TILLAGE 
 
 

PRIMARY TILLAGE     SECONDARY TILLAGE 
 
Moldboard Plow  fp (fall)  sp (spring)   Disk, tandem heavy primary 
        Disk, tandem light finishing 
        Harrow, coiled tine 
 
 
 
 
 

CONSERVATION TILLAGE 
 

CHISEL TILLAGE OPTIONS 
 

PRIMARY TILLAGE     SECONDARY TILLAGE 
 
Chisel, twisted  fctw (fall)  sctw (spring)  Disk, tandem heavy primary 
 (high tillage/low residue)    Disk, tandem light finishing 
 
 
Chisel, straight fcst (fall)  scst (spring)  Disk, tandem heavy primary 
 (moderate tillage/moderate residue)   Disk, tandem light finishing 
 
 
Chisel, sweeps  fcswp (fall)  scswp (spring)  Cultivator, field 6-12” sweeps
 (low tillage/high residue) 
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DISK OPTIONS WITH LOW TO HIGH RESIDUE OPTIONS 

 
 

PRIMARY TILLAGE     SECONDARY TILLAGE 
 
Disk, heavy/offset fdos (fall)  sdos (spring)  Disk, tandem heavy primary 
 (high tillage/low residue)    Disk, tandem light finishing 
 
 
Disk, tandem heavy   fdt (fall)  sdt (spring)   Disk, tandem heavy primary 
 (moderate tillage/moderate residue)   Disk, tandem light finishing 
 
 
Disk, tandem  fds (fall) sds (spring)   Disk, tandem secondary 
 (low tillage/high residue) 
 
 
 
 

FIELD CULTIVATOR OPTIONS 
1 & 2 in symbol denotes the number of implement passes 

 
 
PRIMARY TILLAGE     SECONDARY TILLAGE 
 
Cultivator, field; 6-12” sweeps        none     
ffc1 (fall)  sfc1 (spring)  
 
Cultivator, field; 6-12” sweeps         Cultivator, field; 6-12” sweeps 
ffc2 (fall)  sfc2 (spring) 
 
 

OTHER TILLAGE OPTIONS 
Seedbed Conditioner 
1 Pass Vertical-Till or Turbo-Till High residue crop STIR Value* <30 

If vertical tillage is used to chop stalks or minimally incorporate manure with surface residue, the STIR 
value cannot exceed 30, only one pass can be made in the field, and only on a high residue crop.  
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Planting Operations Naming Codes and Abbreviations 
 
 
The following is a listing of planting operation codes and abbreviations used in the 
preparation of crop templates for the crop management zones.  Listed below the planting 
options are the codes or abbreviations in bold, i.e. nt, that are part of the crop template name. 
 
 
 

GENERAL PLANTING NOTE 
 

For crops that may be drilled or planted, such as soybeans or narrow row corn, the 
abbreviations will be: 
 
Narrow row:  nr 
Wide row:  wr 
 

 
NO-TILL NOTES 

 
 
Drilled crops, no-till single coulter on 7-10” spacing:  nt 
 
Planted crops, no-till 15” or wider rows with fluted coulter:  nt 
 
 

 
STRIP/ZONE TILL NOTES 

 
Planted crops, strip till, wide row:  nts 
 
 
 

RIDGE TILL NOTES 
 

Planted crops, ridge till, wide row:  rt 
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